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[bookmark: _Toc155601447]Guidance on how to use this template
AgriFutures Australia is looking forward to sharing your project outcomes to ensure they are widely disseminated and adopted on-farm and within industry.
To ensure your report hits the mark, this template can be used to format your work before submitting in our project management system, K2.
This guide is designed to help you get the most out of the template and to ensure the outcome of your research is informative, accessible and easily understood by a broad audience.
Should you require further assistance, please contact your relevant AgriFutures Australia Program Manager.
Note: This guidance should be deleted upon submission of your deliverable.

[bookmark: _Toc90306464][bookmark: _Toc93914873][bookmark: _Toc155601448]General guidelines
· Your final deliverable must be accessible in its presentation and language to enable effective extension and adoption within industry. Communicating your work in an accessible way can be tricky but is important to ensure the project has meaningful impact.
· Your final deliverable must be uploaded against your project in AgriFutures Australia’s online project management system, K2. Refer to the Submitting a Final Deliverable Guide within the K2 guides and log-in section of the researchers’ page on the AgriFutures Australia website.
· Your final deliverable must be ready for publishing. Before submitting, please ensure it has been approved as applicable and peer reviewed (if required), and has been proofed and edited.
· If the deliverable, or part thereof, is confidential and its publication may extinguish intellectual property rights, then please clearly state this when uploading it into K2.
· If the deliverable is to be under embargo, please ensure details are included when uploading into K2, including an expected publication date.
· Before commencing, please ensure that you have the latest Final Deliverable Template – refer to Existing Research section on the researcher page of the AgriFutures Australia website for the most up-to-date version.
· By submitting the deliverable in an AgriFutures Australia template, the author acknowledges that the material may be edited and published by AgriFutures Australia.
· The Australian Government Style Manual is a useful tool for various writing, grammar, punctuation and other conventions. It can be found here: https://www.stylemanual.gov.au/. For conventions not detailed below, please adhere to the Australian Government Style Manual.

[bookmark: _Toc90306465][bookmark: _Toc93914874][bookmark: _Toc155601449]Headings and text
The Final Deliverable Template has a series of heading styles embedded in it. These are to ensure consistency throughout and means you can automatically generate a table of contents once you have completed your writing.
Please avoid using automatic numbering on headings – if required, number headings manually.
When generating a table of contents, table lists and figure lists, please have the hyperlink box ticked. This enables interactive lists when PDF files are generated.
The heading styles are:
Heading1 (Product Sans, 22pt, bold)
Heading2 (Product Sans, 16pt, bold)
Heading3 (Product Sans, 14pt, bold)
Heading4 (Product Sans, 12pt, bold)
Heading5 (Product Sans, 12pt, italics)

Body text is Times New Roman, 11pt




[bookmark: _Toc90306466][bookmark: _Toc93914875][bookmark: _Toc155601450]AgriFutures Australia final deliverable structure
[bookmark: _Toc90306467][bookmark: _Toc93914876][bookmark: _Toc155601451]Preliminary pages
The preliminary pages in the deliverable should be numbered with Roman numerals, and set out in the order outlined below. The Final Deliverable Template has the Roman numerals automatically embedded – please avoid adding section breaks, as this will disrupt the page numbering.
Page i: Deliverable title
Replace the highlighted text with appropriate information. If the information does not fit on one page, you may need to adjust spacing. The title page should not display a page number.
Page ii: Disclaimer page
All text on this page should remain. Replace the highlighted text with the appropriate information.
Page iii: Foreword
The foreword will be written by your AgriFutures Australia Program Manager.
Page iv: Acknowledgements, Abbreviations and/or About the author
Fill out these sections if they are relevant to your project.
Page v: Contents
A table of contents has been included. If you follow the heading hierarchy, your headings will automatically be included when it is updated (right-click the contents list, go to ‘Update Field’).
Page vi: Executive summary
The executive summary is your opportunity to provide the reader with an overview of your project. It should be able to stand on its own and inform someone who has no prior knowledge of the research about why it was conducted, what it found, what it means, and what your recommendations are. 
[bookmark: _Toc90306468][bookmark: _Toc93914877][bookmark: _Toc155601452]Deliverable body 
The body of the deliverable should be set out in a number of chapters. Chapter titles should be determined by the author, and should suit the piece of work. Suggested chapter titles are:
· Introduction
· Objectives
· Methodology
· Results
· Discussion
· Implications for industry (to answer the ‘what does this mean?’ question)
· Recommendations (to detail what you recommend as a result of the work)
· References
· Appendices
[bookmark: _Toc90306469][bookmark: _Toc92981794][bookmark: _Toc93914878][bookmark: _Toc155601453]Formatting conventions
The template is set for A4 pages, with top, bottom, left and right margins all set at 2.54 centimetres. All text should be left-justified. Headings are set in Product Sans and body text should be set in Times New Roman 11pt (use the styles provided). Note that paragraph spacing has been embedded in the styles, so there is no need for an extra return between paragraphs.


[bookmark: _Toc90306470][bookmark: _Toc92981795][bookmark: _Toc93914879][bookmark: _Toc155601454]Lists, bullets and dashes
The default style for bullets has been included in the template. It is:
Bullet
Circle
Square
As a rule of thumb, a list should be introduced with a colon, and list items should start with a capital letter. 
As a guide, put a full stop at the end of list items if the item is lengthy. Do not put a full stop at the end of a bullet point item if the text is brief or is a single-word list.


[bookmark: _Toc90306471][bookmark: _Toc92981796][bookmark: _Toc93914880][bookmark: _Toc155601455]Quotes
If you are including quoted material, this can be done in two ways. For short quotes, use double quote marks to highlight the quoted text within the paragraph. For block quotes, set them in a separate paragraph and use the ‘Quote’ style from the toolbar.
“The quoted text will look like this. Generally it is only necessary to set quoted text as a block quote when the quote contains 30 or more words.” – Quoted person


[bookmark: _Toc90306472][bookmark: _Toc92981797][bookmark: _Toc93914881][bookmark: _Toc155601456]Information in a breakout box
The ‘Intense Quote’ style in the toolbar allows you to place greater emphasis on an important piece of information. This can be effective when you want to make key messages and sentences more prominent. Think about how breakout quotes are used in newspapers.
The breakout information will look like this. This style works most effectively when the passage is 30 words or more.
[bookmark: _Toc90306474][bookmark: _Toc92981798][bookmark: _Toc93914882][bookmark: _Toc155601457]Tables and figures
If you are including tables and figures, you need to generate their captions properly.
1. Place your cursor where you want the caption to be generated. Under the References tab, click ‘Insert Caption’.
2. Type the text for your caption. Make sure the correct label is set (either ‘Table’ or ‘Figure’).
3. Hit enter. Your caption should appear.
4. Highlight the caption and re-style it as per ‘TableCaption’ and ‘FigureCaption’ in the styles list. This will amend the formatting to Arial Bold 9pt, the style used by AgriFutures Australia.
Table captions should be placed above the table. Figure captions should be placed below the figure.
Tables appear cleanest when a sans serif font is used, such as Arial 9pt. As a general guide, spacing should be set as 2pt both before and after the text (set this under the Layout tab).

[bookmark: _Toc90306594]Table 1. Example table caption.
	Heading 1
	Heading 2
	Heading 3
	Heading 4

	List item A
	
	
	

	List item B
	
	
	

	List item C
	
	
	

	List item D
	
	
	



When you have data to present in a chart or graph, it is recommended you use the ‘Add a Chart’ tool within Microsoft Word, rather than pasting in a screenshot or inserting a PNG file of your chart. This enables you to use the functionality afforded by Word. Of course, this may not be possible for all types of graphs, charts and ways to present complex scientific statistics.


[bookmark: _Toc90306602]Figure 2. Example figure caption.
[bookmark: _Toc90306473][bookmark: _Toc92981799][bookmark: _Toc93914883][bookmark: _Toc155601458]Boxed text
If you have some text you would like to highlight in a box (for example, a case study), it is best to use a text box with a fill colour and a different font, so it stands out from the rest of the report text.
Case study: Title of your case study
This is an example of boxed text for a case study. The heading is Product Sans 14pt and bold, and the body text is Arial 10pt.
The background colour (#FFEFC9) is a fade of the orange used by AgriFutures Australia’s levied industry programs. 
The paragraph spacing is 11pt.

Case study: Title of your case study
This is an example of boxed text for a case study. The heading is Product Sans 14pt and bold, and the body text is Arial 10pt.
The background colour (#C7F1FF) is a fade of the blue used by AgriFutures Australia’s Emerging Industries Program. 
The paragraph spacing is 11pt.

Case study: Title of your case study
This is an example of boxed text for a case study. The heading is Product Sans 14pt and bold, and the body text is Arial 10pt.
The background colour (#F5D6D5) is a fade of the red used by AgriFutures Australia’s Rural Futures Program. 
The paragraph spacing is 11pt.

[bookmark: _Toc90306475][bookmark: _Toc92981800][bookmark: _Toc93914884]
[bookmark: _Toc155601459]Page numbering
Page numbers have already been set up in the template. The cover page is page i (however the number does not appear on the cover). Page numbers continue using Roman numerals for the Disclaimer, Foreword, Contents and Executive summary, and then restart at 1 from the Introduction onwards.




[bookmark: _Toc155601460]Numbering
You can number your chapters and subheadings, but numbers should be inserted manually. Please do not use the automatic numbering function, as this can cause problems for the publishers. Please do not number paragraphs. 
Bullets are preferrable for list items, however numbers can be used when, for instance, you are detailing steps that were followed in a procedure. 

[bookmark: _Toc90306476][bookmark: _Toc92981801][bookmark: _Toc93914885][bookmark: _Toc155601461]Section breaks
Section breaks can be used when swapping to/from landscape pages. However, please do not insert additional section breaks.
To insert a section break, click on the Layout tab; under ‘Breaks’, click ‘Next Page’.
Please ensure the page number on your new page continues on from the previous page. This can be done by double-clicking on the page number, then going ‘Format Page Numbers’.

[bookmark: _Toc90306477][bookmark: _Toc92981802][bookmark: _Toc93914886][bookmark: _Toc155601462]Graphics and photographs
We recommend that you include photographs relevant to the project. These illustrate the text, and are also used to produce covers and promotional material.
If your deliverable includes photographs and graphics, please send these as separate files as well as inserting them in your report them. Captions and credits for photographs should also be provided.
Please contact AgriFutures Australia for an online cloud storage link to upload photographs and graphics, if required. Ensure that the file name of the photographs or graphics corresponds with the caption in the deliverable (i.e. Figure1_GVPgraph.jpg, Figure2_IndustrySupplyChain.jpg).
Where possible, ensure photos/graphics are high quality and of a publishable standard. Please avoid re-sizing photos – high-resolution photos of a suitable size (>2mb) are preferred.
The preferred formats for photographs are TIFF (filename.tif) and JPEG (filename.jpg).
The preferred formats for vector graphics (graphs and computer-generated diagrams) are SVG, EPS or AI (Adobe Illustrator). Microsoft Word recognises SVG files, so you will be able to insert these into your report. The SmartArt function within Microsoft Word is also useful to create graphics, such as flow charts.
Please indicate whether there is any copyright on photographs, and consider whether the source or photographer needs to be acknowledged.
If graphics or photographs have been taken from a copyright source (including websites), the author is responsible for arranging publication permission.

THIS IS THE END OF THE TEMPLATE GUIDANCE

[bookmark: _Toc155601463]Foreword
To be completed by your AgriFutures Program Manager
Your foreword should address the following:
A basic background that is relevant to the project. What should we know about the industry?
What is the problem that the project is addressing? Why the need for this work?  
What were the key findings? What do the key findings mean for the industry?
What are the key recommendations? What practice change should happen as a result of this project? What is the takeaway for producers and industry?
You should also include a paragraph giving details of funding received for the project.
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About the author
Delete if not relevant
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[bookmark: _Toc155601467]
Executive summary
The executive summary is your opportunity to provide the reader with an overview of your project. It should be able to stand on its own and inform someone who has no prior knowledge of the research about why it was conducted, what it found, and what your recommendations are. 
Good executive summaries are generally between 5-10% of the length of the full report (i.e. one to two pages for a 20-page report), although should not be longer than five pages.


[bookmark: _Toc155601468]Introduction
Your introduction is an opportunity to set the scene. Use this space to convince them why the research is important and what identified problem it solves.
Include background on the industry and why the issue/problem being researched is a priority. Detail any previous research in the field and what led you to undertake this research.
A well-written introduction enables the reader to identify the knowledge gap that this project attempted to fill.
Explain key issues, concepts, terminology and definitions that will aid understanding of subsequent sections. Detail any hypotheses that formed the backbone of the research.


Objectives
Objectives of the project – as agreed in the contract.
Note: This is your final deliverable for the project, and so objectives should be written in past tense; ‘The objectives of this project were …’



Methodology
Describe the methods used. Where relevant, provide insight into why the methodology is the most appropriate to answer the research question.


Results
What were the results/key findings from the research conducted?
Provide detailed results, including tables and figures where relevant. Include explanation of the results and what you see in them.




Discussion
Use this section to discuss what the results show and how the results address the objectives. 
What outcomes can be drawn from the results? How do the results compare to any hypothesis?
If relevant, discuss how your findings relate to other work already undertaken in the field.


Implications
AgriFutures Australia places great emphasis on ensuring research findings are effectively extended into industry, to enable widespread adoption and implementation. Substantial reflections about the impact that your research could have will contribute to this effort.
In this section, detail the impact the findings could have, should they be widely adopted. 
What do the findings mean in a practical sense? Who will the research impact? Will impacted stakeholders/industry benefit from the findings? If so, how? Why should stakeholders/industry adopt outcomes from the research?
If relevant, include an assessment of the potential economic impact. For example, is there an estimated return on investment? Is there an expected practice change stemming from adoption?


Recommendations 
AgriFutures Australia places great emphasis on ensuring research findings are effectively extended into industry, to enable widespread adoption and implementation. Detailed recommendations (including who they are targeted at) will contribute to this effort.
In the context of your findings, detail what you recommend happens from here.
Does further research need to be conducted? Are there extension activities that would enable the benefits to be realised? What should relevant stakeholders/industry do with your research outcomes? What are the actions and next steps as part of research adoption?
If appropriate and relevant, provide recommendations as to how the results of the project can be commercialised.
These should be straightforward and easy to understand, provide a clear implementation strategy and detail what actions should be taken and by whom. They should be detailed enough to get the point across but not include more discussion.



Appendices
If required.


References
References/cross-references. Please use Australian Harvard to style your references.
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